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Color Matching & Retouch

I encountered several challenges in retouching the image featured in this video, 
and I would like to walk you through the steps I took in fixing and optimizing the 
photo. In the process, you’ll learn how to match colors across multiple locations in 
an image as well as some different retouching techniques. 

Let’s look at the issues we’re going to tackle: 

We’ll start by adjusting the overall image in 
Lightroom. The first thing we’ll do is correct for 
any distortion. Under the Lens Corrections pan-
el within the Develop Module, we’ll turn on the 
check boxes to “Remove Chromatic Aberration” 
and “Enable Profile Corrections.” We also want 
to make sure that any vertical lines in the build-
ing are perfectly vertical, and we’ll do that within 
the Transform panel. We’ll click on the icon in the 
top left corner of the panel in order to activate 
the Guided Upright feature. This will allow us to 
click and drag out lines on the image, defining 
edges that should be perfectly horizontal or per-

At left is the original image. At right, we’re highlighting the areas we want to retouch. 

In the Lens Corrections panel, we 
turned on the check boxes to Re-
move Chromatic Aberration and 
Enable Profile Corrections. 
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fectly vertical. The tool allows us to drag out up to two vertical and two horizontal 
lines, and you won’t see any change in the image until two lines have been created. 
We’ll draw out one line that runs along the right edge of the building and another 
line that runs along the left edge of the building. 

Now we’ll work on the overall tone of the image. Because 
there are really bright highlights and REALLY dark shad-
ows, we need to optimize contrast to get more shadow 
detail in the image. Before working with the tonal sliders, 
we’ll look at the color profile of the image. We can do that 
by using the Profile setting, which can be found at the top 
of the Basic panel. Click on the icon to the right of the Pro-
file menu (it looks like four rectangles) and a list of avail-
able profiles and profile categories will expand. We’ll click 
to expand the Adobe Raw profiles and hover the cursor 
over each one to see a preview of the effect in the main 
image window. Most of them have a negative effect on the 
shadows, with the exception of the Adobe Neutral profile. 
This profile actually lightens the shadows, and this is what 
we want, so we’ll click to apply it and then we’ll click the 
Close button in the top right corner of the Profile panel. 

The Guided Upright 
feature is being 
used to drag out 
lines, defining edg-
es that should be 
perfectly vertical.

The Adobe Neutral pro-
file was chosen because 
it works well with mid-
day scenes that create 
too much contrast in the 
image.
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Next, we’ll optimize the image using the sliders in the Basic 
panel. My main concern is that the shadows are too dark, 
so we’ll drag the Shadows slider to the right until we can 
see a good amount of detail in those areas. I’ll also bump 
up the contrast and drag the Clarity slider to the right in 
order to make the fine details pop out a bit more. Working 
with the colors, I’ll lower the Vibrance setting in order to 
tone down the more mellow colors (I only want the vibrant 
colors to really pop). Then I’ll bring the Saturation slider 
up to make the image more colorful as a whole. We’ll then 
take the White Balance Eyedropper and use it to click on 
an area in the white building to ensure that the building is 
truly white.

After working through the sliders, we’ll then move on to adjust individual areas of 
the image with the Adjustment Brush.  The main goal is to tone down the areas 
not important to the scene so that the eye is naturally drawn toward the bus and 
the building. The following adjustments will be made to achieve that:

• Lower the saturation of the door on the right side of the building as well as the 
pavement surrounding the building

• Lower the saturation of the sign on the building

• Lower the saturation of the building in the background

• Darken the shadows and lower the contrast and clarity on the Mini Cooper

Now that the initial adjustments have been made, it’s time to send the image 
over to Photoshop. We can do that by using the keyboard shortcut Command+E 
(Ctrl+E on Win). Alternatively, you can go to the main menu and choose Photo > 
Edit In > Edit in Adobe Photoshop.

Above, you can see the 
adjustments made using 
the Basic panel sliders.
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At this point, you’ll need to decide whether you’re going to do the retouching on 
the original image layer or on an overlying empty layer. If you want to do your 
retouching on an empty layer, create a new layer by clicking the New Layer icon 
at the bottom of the Layers panel. When working this way, you’ll need to ensure 
that the sample settings for the different retouching tools are set to “Sample All 
Layers” or sample “Current & Below.” These settings can be found in the Options 
Bar when the tool is active. 

Retouching the tower and telephone lines

We want to remove the tower and telephone line 
near the top of the image, but that’s not going to 
be a straightforward process because these items 
take up so much room in the frame. The Spot Heal-
ing Brush works much better on smaller areas. To 
start, we’ll use the Clone Stamp Tool and break up 
the telephone line into smaller pieces. We’ll take 
extra care in removing the line in the area where 
it comes very close to the top of the building, as 
the other spot removal tools would likely mess up 

Left: The image, before the Adjustment Brush was used. Right: The image, after the Adjust-
ment Brush was used.

The Clone Stamp Tool is being 
used to break up the telephone 
line.
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in this area. With the Clone Stamp Tool, hold 
down the Option key (Alt on Win) and click to 
sample an area that you want to use to cov-
er up the unwanted object. Then release the 
Option key and click and drag to paint over 
the object. You will see a preview inside of 
the brush tip that shows what content will be 
pasted there. 

Once the telephone line has been broken up 
into smaller pieces and separated from the 
other objects in the frame, we’ll use the Spot 
Healing Brush to paint over the individual piec-
es to remove them. 

Next, we’ll move on to the tower. We’ll use the 
Clone Stamp Tool to separate the tower from 
the top of the building, sampling from some-
where on the top edge of the building and 
then painting over the tower where it comes 
in contact with the building. Because of all the 
small details, we’ll have to use a small brush 

The Clone Stamp Tool was used to break the telephone line into smaller pieces, making it 
easier to remove.

The Spot Healing Brush is being used 
to remove the pieces of telephone line.

The Clone Stamp Tool is being used to 
separate the tower from the building.
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that has a fairly hard edge to separate the small poles from the top of the build-
ing. We’ll also break up the tower about half way up, as this will help later when 
removing the pieces with the Spot Healing Brush. 

The Spot Healing Brush can now be used to paint over the isolated parts of the 
tower. We’ll paint over the entire thing, leaving gaps in the areas of sky so that the 
tool can use the color information in those areas to fill in the places we’re painting. 
If the tool is unsuccessful in some areas, we can simply go over those areas again 
using the same technique. 

Now the tower and telephone line have been removed, but we need to check to 
make sure that the sky area looks smooth. (Sometimes the retouching tools can 
create a subtly blotchy result.) To do this, we’ll create a Curves adjustment layer 
by clicking on the Adjustment Layer icon at the bottom of the Layers panel and 
choosing Curves from the pop-up menu. We’ll make sure the targeted adjustment 

After the tower was broken up, the Spot Healing Brush was used to remove it. 
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feature is turned on (It looks 
like a hand icon on the left 
side of the Curves Proper-
ties panel) and we’ll hover 
our cursor over the sky area. 
Looking at the curve, a point 
will appear, representing the 
area under the cursor. In an 
image with a lot of sky area, 
there will likely be a big hump 
in the curve that represents 
that area. We’ll click to add 
points on either end of that 
hump. We’ll drag one of the 
dots straight up and the other straight down. This will create an extreme adjust-
ment in the sky that will exaggerate any blotchiness. In our example, we can see 
some of that blotchiness in the area we did our retouching. 

The hand icon was turned on and we’re using the eye-
dropper to locate the area of the curve that represents 
the sky.

Left: A point was added on either end of the hump in the curve that represents the sky. 
Right: The points were dragged way down and way up to create an exaggerated adjustment 
that reveals any blotchiness in the sky.
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With the Curves adjustment layer 
still visible, we’ll click back on our re-
touching layer to make it active and 
we’ll continue to work on the sky 
area with the Spot Healing Brush, 
trying to create a smoother look. If 
this isn’t successful, we’ll switch to 
the regular Healing Brush because 
this tool allows us to choose a sam-
ple area. This can give us more con-
trol over how the retouching is hap-
pening. 

Tip: When retouching smooth areas of color, like skies, it’s best to make sure the 
image is in 16-bit mode. This mode includes thousands more brightness levels 
than 8-bit so the areas of solid color, as in skies, remain smooth-looking when re-
touched.

After the sky area has been retouched, we can throw away the Curves adjustment 
layer, as it was only used to show us where there might be blotchy areas that we 
needed to address. We’ll drag it to the trash can at the bottom of the Layers panel. 

Retouching the car 

There are two ways that we can tackle the red car in the image. We can either 
darken the back of the car (the part that’s in the sun) to make it look as if it’s in 
the shade and therefore be less noticeable, or we can remove the car completely. 
Let’s look at both options.

First, we’ll try to make the back of the car look like it was in the shade. To do this, 
we’ll need to use a color-matching technique. We’ll first make a selection around 
the bright red area by using the Quick Selection Tool. When using this tool, it’s best 
to turn on the Auto-Enhance check box found in the Options Bar. If you’re doing 

After creating the extreme adjustment, we ca see 
that there are blotchy areas in the sky that need 
further retouching.
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your retouching on an empty layer, you’ll also need to turn on the Sample All Lay-
ers check box. Next, we’ll create a Hue/Saturation adjustment layer by clicking on 
the Adjustment Layer icon at the bottom of the Layers panel. Because we had a 
selection active, that selection is automatically applied to the mask that’s attached 
to the Hue/Saturation adjustment layer. This makes it so any change we make us-
ing this adjustment layer will only be visible in the area where the selection was. 

In the Properties panel for the Hue/
Saturation adjustment layer, we’ll 
make sure the little hand icon in 
the upper left is turned on. Then, 
we’ll use the eyedropper to click in 
the area of color we want to affect. 
In this case, it’s the bright part of 
the car. When we click using this 
tool, it automatically changed the 
color menu to Reds, which means 
the sliders will only affect the se-
lected hue. It also targeted the 
specific color on the sliders at the 
bottom of the panel, centering the 
sliders on the exact color of the car. 
Now, we’ll work with the HSL slid-
ers, attempting to get the targeted 
part of the car to match the rest 
of the car, which is in the shadows. 
We’ll drag the Lightness slider to 
the left until the area is just as dark 
as the rest of the car. After doing 
this, I notice that the area does not 
look as colorful as the rest of the 
car, so we’ll drag up the Saturation 
slider until they look the same. 

We activated the hand icon and clicked on the 
bright red area of the car we want to target. 

The HSL sliders are being used to match the target-
ed area to the rest of the car. The Lightness slider 
was moved way down and the Saturation slider was 
moved slightly up.
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At this point, we can see that the 
transition is not smooth, which 
just means that the selection 
was not perfectly accurate and 
therefore the mask is not per-
fectly targeting the area of the 
car we want to change.  It will 
be difficult to create a perfect 
mask, so instead of working fur-
ther on the mask, we’ll create a 
new, empty layer above the Hue/
Saturation adjustment layer and 
we’ll use this layer to retouch the 
line created by the rough transi-
tion.  Working on this empty layer, we’ll activate the Spot Healing Brush and use 
it to paint over the line. If the Spot Healing Brush doesn’t work the way it should, 
then we’ll switch to the Healing Brush because with this tool, we can manually 
choose the sample area. 

We used a Hue/Saturation adjustment layer to color-match the back of the car 
because the area contained a great deal of color. Had the area been less colorful, 
the Hue/Saturation adjustment would not have been as effective and we would  
have instead had to use a Curves adjustment layer to do the color matching. This 
will be the case on the top of the car, where the bright area is white. 

To make the light part of the car roof match the area that’s in the shadows, we’ll 
again make a selection around the area using the Quick Selection Tool. When us-
ing the Quick Selection Tool, we’ll again make sure that the Auto-Enhance check 
box is turned on and that the Sample All Layers setting is turned on as well. Then, 
we’ll create a Curves adjustment layer and make sure that the hand icon on the left 
side of the Properties panel is turned on. Using this tool, we’ll hover the cursor over 
the area we want to change (the bright roof of the car), hold down Shift+Com-

The Spot Healing Brush is being used on an empty 
layer to retouch the abrupt transition.
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mand (Shift+Ctrl on Win) and click in that 
area. This will place a point on each of the 
color curves. We’ll switch the color menu 
at the top of the curves chart to Red. Then, 
we’ll hover our cursor over the part of the 
roof we want to match the selected area to. 
In this case, it’s the part of the white roof 
that’s in the shade. We’ll note the Input/Out-
put number beneath the curve chart. Then, 
we’ll move the cursor away from the image 
again and enter that number into the Out-
put field. This will drastically change the 
color in the image but we can ignore that 
for now. We’ll then change the color menu 
above the curves chart to Green and follow 
the same process, hovering the cursor over 
the sample area, noting the number beneath 
the curve chart and then typing that number 
into the Output field. We’ll finally change the 
color menu to Blue and do the same thing. 

Now, the tones are starting 
to match, but we have an 
abrupt transition. Looking 
at the three different color 
curves, any time you see 
the line topping out or bot-
toming out (as it’s doing in 
our case), you’re not going 
to have a smooth transi-
tion. If this is the case, click 
to add a point on the curve 

When color-matching using the Curves 
adjustment, we want to match the Out-
put number of the target area to the 
Output number of the area we’re trying 
to replicate.

The Blue curve is bottoming out, creating an abrupt transi-
tion in the image.
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at the end of where 
it’s bottoming out and 
then move the point 
up or down to create 
as smooth of a curve 
line as possible. 

Now we can see that 
the area we’re target-
ing is starting to match 
the rest of the car’s 
roof, but there’s still an 
abrupt transition. It al-
most looks like there’s 
an outline around the 
area. We’ll use a soft-

edged brush and paint on the mask to try and blend the area in better. We can 
also retouch out the transition line by working on a new, empty layer and painting 
over the transition using the Clone Stamp Tool (or whatever retouching tool you 
feel would be most appropriate). 

The other option we have with this image is to retouch the car out completely. 
Let’s look at a few tips relating to that process: 

The car is partially blocking two identical garage doors. It’s blocking the right half 
of one door, and the left half of the other door. We can make a selection around 
the door that’s blocked the least and copy that content onto its own layer. Because 
the area we want to copy is made up of several different layers, we need to use 
the Copy Merged command, which will copy a flattened version of the image to 
its own layer. You can do this by using the keyboard shortcut Shift+Command+J 
(Shift+Ctrl+J on Win) or by going to the Edit menu and choosing Copy Merged. 
Then, we’ll go back to the Edit menu and choose Paste. We can now use the Move 
Tool to position the copied content over the other door, therefore hiding the car. In 

We clicked to add a point in the area where the curve was bot-
toming out and we’re dragging the point to create a smoother 
curve.
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order to see how the layer is lining up with the underlying content, we can change 
the blending mode of the layer to Difference (this will give us a view that shows 
you where the layer differs from what’s underneath) or to Darken. 

Looking at the copied content, we’re going to have to apply further transforma-
tions to the layer in order for it to match up correctly. Before applying these trans-
formations, we’ll turn the layer into a Smart Object by going to the Layer menu 
and choosing Smart Objects > Convert to Smart Object. 

Now we’ll use the Free Transform command in order to bend the content of the 
layer to match what’s underneath. You can activate the Free Transform command 
by using the keyboard shortcut Command+T (Ctrl+T on Win). When the Free 
Transform handles are active, a crosshair will appear in the middle of the con-
tent you’re transforming. You can click and drag on that crosshair to move it to a 
different location, defining the center anchor point for the transformation. We’ll 
move that crosshair to an area where the layers DO line up. In our case, it’s an area 
where the horizontal grout lines between the bricks line up. Then, we’ll hold down 

A selection is 
being made of 
an area that 
we’re going 
to copy. We’ll 
use the copy to 
hide the part of 
the other ga-
rage door that’s 
obstructed by 
the car.



Color Matching & Retouch © Ben Willmore, All rights reserved 15

Shift+Option (Shift+Alt on Win) in order to keep the content aligned with the 
crosshair and we’ll drag one of the corner transform handles to line up the layers. 
Once we’re satisfied, we’ll hit the Return/Enter key to lock in the transformation 
and then set the blending mode back to normal. 

We’ll use a layer mask to control where the layer shows up. In this case, we’d like 
to start with a black mask (one that hides the entire layer) and then use a white 
brush to paint in the areas where we want the layer to be visible. To create a layer 
mask that’s black, hold down the Option key and then click on the Layer Mask icon 
at the bottom of the Layers panel. Then, we can paint with white over the garage 
door, bringing in parts of the layer that need to be used to hide the car. We can 
also hit the backslash key to show the mask as an overlay, which can sometimes 
help in seeing where we’re painting on the mask. 

We’re painting on the layer mask in order to bring in the parts of the layer we need to hide 
the car.


